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I. Connection to the system and Downloading of initial data 
A. The connection operation is the same as in previous versions of 

software where the user may select the online or remote connections 
to interface with the system.   

 
B. A few new features which have been added are: 
 

1. The communication port selection pull-down can now 
accommodate up to 20 communication ports, and shows only the 
communication ports available. 

 

 
 

a. A sub-feature to this is, if a communication port is available and 
the communication port is busy, it is still shown on the list, but 
if the user tries to connect to the system using that port, the 
software informs the user that the port is being used by another 
application, and that other application should be closed before 
communications with the system can be established using that 
port. 
 

2. The View Log feature under the Tools->Options menu on the 
General tab allows the user to view the last communication session 
with the system and informs the user of any problems in the 
upload or download of data.  Each program number listed in the 
Program column will represent a communication problem (not all 
serious), and the problem type will be listed in the Event column 
next to the program number column.  
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3. The software will now remember the password entered by the 
user if the Remember Password checkbox is selected.  The 
password and checkbox values will be saved to the 
configuration file upon program exit, and the data will be read 
from the file when the application starts.  The remembered 
password will be written into the Password field automatically 
when this option is active. 

 

 
 
 

C. New functionality when connecting to the system and a new way the 
system receives and transmits data. 

 
1. The software now connects to the system and immediately gets 

only the data it needs as a baseline to operate.  This includes the 
entire System Numbering plan, the slot assignments, and the 
System Programming (so the first programming button’s (System 
Button) data may be displayed when ready). 

 
2. Once this data has been received, the system now goes out and 

gets the data in a pre-defined manner, unless the user clicks on a 
specific navigation or program group button, and that data 
requested has not yet been received, the software will prioritize 
getting the requested data first and display the subject screen 
completely greyed out until that data has been retrieved from the 
system (as seen below). 
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a. If the user let the program retrieve the data on it’s own, the 
program goes out and gets the System data, the Toll 
Restriction Data, the Speed Dial Data, the FIRST Extension 
Data, the FIRST Trunk Data, the DSS data, the Voice Mail 
data, and finally the subsequent Trunk and Extension data in 
order (by port data group unless pre-empted by the user, so 
all 1001, 1003, 1004, 1005, 1006, 1701, 1703, 1705, 1801, 
1802, 1803, 1804, 1805, 1806, 1807, & 1808 data for a 
specific port number is defined as a “port data group”). 

 
b. If the user clicks on a specific program group, the software 

will prioritize the order of the data retrieval to get the 
requested data as soon as possible.  If the software is 
downloading a certain program group, and the user clicks on 
another group, which has not been downloaded yet, the 
program will display the specific data group screen greyed 
out while the current downloading program group retrieval is 
finished and the requested group is retrieved.  Once the 
requested group is retrieved from the system, the page will 
be refreshed with the newly received data on it. 
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c. The specific navigation button mentioned above is any of the 
navigation or data manipulation buttons, in the Trunk and 
Station pages.   

 
1. The First, Next, Previous, or Goto buttons (when clicked) 

will check to see if the system data has been received.  If 
it has, the navigation will be performed immediately; 
otherwise, if the data has not been received for any 
reason, the software retrieves the data for that port 
being navigated to and jumps to that port as soon as the 
data has been received. 

 
2. The Copy and Swap buttons will also check to see if the 

data for a port being copied from has been retrieved, if 
not these functions will get that data before any further 
action is taken. 

 
3. The Default button does not need to do this because the 

default button only works on the current port. 
 

3. If the entire database is not completely received from the 
system, but the user has made changes to the available data 
and wishes to send those changes to the system, the user may 
simply click “SEND” right away, unlike having to wait until the 
upload or download processes are completed as in the single-
threaded version of the system administrator. The currently 
downloading program group data or port data group (if any) will 
complete receiving, and then the receive process will be paused 
while the data requesting to be sent to the system will be 
transmitted.  This data transmission being completed, the 
process of retrieving the rest of the system data not yet 
received from the system will recommence. 
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II. Operations once the initial connection and download are performed 
 

A. New way to exit the connected mode. 
 

1. If the user is either uploading or downloading data, there is now a 
way to stop the process and exit the communication mode without 
waiting for the entire database to be downloaded or uploaded.   
 
a. Exiting on an active download can be accomplished by clicking 

the break connection button and a message box will ask the 
user if they would to Terminate Now or Cancel the Break 
Connection request.  If the user selects the Terminate Now 
option, the program connection to the system will terminate as 
soon as the currently downloading program group or port data 
group is finished.  Clicking Cancel will let the active download 
continue on uninterrupted. 

 

 
 

b. Exiting on an active upload is a little different, but can still be 
requested by clicking the Break Connection button.  When this 
is done while uploading, the user is presented with a message 
box which will ask the user if they would like to Terminate 
Now, Cancel the break connection request, or wait until the 
upload of the data is done (Wait Until Done).  The Wait 
Until Done option will allow the upload of the data process to 
complete before breaking the connection with the system, 
otherwise the Terminate Now and Cancel options operate as 
mentioned in the break connection while downloading section. 
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c. Clicking the X-BOX (close box) in the upper right of the main 
dialog window will terminate the communication and close the 
entire program as soon as permissible.  No warnings to the user 
are shown here (by design)! 

 
D. Using the File Open and Save options 
 

1. The File->Open and File->Save (As) options operate a little 
differently from how they did in the single threaded version of the 
system administrator. 

 
a. The File-Open function on download 

 
i. This will pre-empt the downloading of data as soon as 

possible and allow the data file to be opened and uploaded 
to the system.  A dialog will be displayed asking the user if 
they would like the file open to run as soon as possible (click 
OK) or try again at a later time manually (click Cancel). (See 
figure below)   Note:  Once you hit OK in this message, the 
download is terminated (that’s it no going back!).  You 
cannot resume the download by hitting Cancel on a later 
dialog in this process.  Hitting Cancel on this dialog will allow 
the download to continue. 

 

 
 

ii. If OK is clicked, as soon as the current program group or 
port data group has been downloaded, the file open dialog 
will appear (See figure below), and the current download 
shall be terminated. Otherwise, the user must initiate the file 
open action again manually, and wait for the entire 
download to finish, or (if it has not completed) select OK on 
the message box presented, if the download has not yet 
terminated.   
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iii. Once the data file has been read in, the program will ask if 
the user wants to immediately upload the data or upload it 
later by clicking on the SEND button. (See figure below) 
 

 
 

iv. Clicking Yes will cause the data upload to commence. 
 

v. Another dialog will appear after this one indicating to the 
user that the upload will take several minutes (although this 
is a multi-threaded program, the communication process is 
still a serial operation and can go only so fast). 
 

b. The File-Open function on upload 
 

i. This action will present the user with a dialog allowing him 
to wait until the end of the current upload of data, and once 
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the upload is completed, allow the data file open dialog to 
be displayed automatically by clicking OK, or cancel the File 
Open request by clicking Cancel. (See figure below) 

 

 
 
ii. Once the file has complete it’s upload, and the user had 

previously selected OK the File Open dialog shall be 
displayed. (See figure below) 

 
 

 
 

iii. Once the data file has been read in, the program will ask if 
the user wants to immediately upload the data or upload it 
later by clicking on the SEND button. (See figure below) 
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iv. Clicking “Yes” will cause the data upload to commence. 
 

v. Another dialog will appear after this one indicating to the 
user that the upload will take several minutes (although this 
is a multi-threaded program, the communication process is 
still a serial operation and can go only so fast). 

 
E. Using the Data Download option. 

 
1. The data download option works in the same way that it has in the 

past, where it can only get data when neither the upload nor the 
download processes are running.  Now, the data download option 
can be requested before the upload and download operations are 
finished processing, and like the file open/save operations, can be 
called automatically when the communications have finished, or 
called manually at a later time. 

 
F. Clicking one option and then another terminates the previous request! 

 
1. When clicking on the Data Download request and indicating OK to 

the message box to wait for the upload/download to finish, then 
clicking on the File Open request, will cancel the Data Download 
request!  This software will only keep 1 pending request at any 
time.  So, the last request made by the user is always the one 
acted upon. 
 

G. How the Online utilities now work. 
 
1. The Online Utilities will now override an upload or download 

process to run, and with the exception of any of the utilities which 
reset the system, the download or upload process will resume it’s 
previous duties, once the utility operation is complete. 

 
H. Navigation through the Trunks and Extensions can now get data 

faster. 
 

1. Unlike with the single-threaded version of the System 
Administrator, this version does not download the port data for the 
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stations and trunks on request of the navigation buttons, unless the 
data has yet not been received.  When the connection to the 
system is made, and the program from the system has received all 
of the primary data, the program begins to download all of the 
remaining station and trunk data by port (port data groups) in the 
background.  The user may be working on other items, and when 
they get to the station or trunk programming, many of the ports 
could already be received from the system.  If the user does try to 
navigate to a port, which is not yet retrieved from the system 
(using the First, Next, Previous, Goto, Copy or Swap buttons), the 
program will finish the current port it is downloading, and then 
immediately receive all of the programs (station and trunk if 
applicable) for the requested port.  This process is very quick and 
the user should wait no more than 10 seconds or so, and while the 
user is waiting, a “Receiving...” message is displayed in the lower 
left corner of the screen on the status bar.  If the ports are already 
received, the navigation to the desired location is now 
instantaneous! 
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